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REGISTRATION 
 
How to Register your Man3000 Software 
• Registering of your Man3000 Software is password protected. 
• The “Technical” Passwords allows editing of the registration form as well as entering 

the registration code. 
• The “Management” Password only allows for the entering of the registration code. 
  

STEP 1 - Location of Form 
 
 
 
 
 
 

• From the Help Menu: “Technical Support” to access the Man3000 Software 
Registration Form. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
• If the copy of Man3000 was not registered and a report was to be run, a warning 

message appears to inform the user that the program is not registered and a  
 

button will be placed on the main screen from where the technician or 
client can access the registration form and enter the registration key.  
 

No password is required to access this                     quick access button and will reset  
 
the password back to           after registration key was entered. This option can only 
be used for entering the registration code and not for editing of the registration code. 
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STEP 2 - Accessing Registration Form 
 
• Once you have opened the registration form, select the               option. A warning 

message will be displayed as soon as the edit button is clicked, this is only to warn 
the individual that any alterations to the registration form will affect the registration 
and if changed need to be re-registered. 

• Continue by clicking "Yes". 
 
 
 
 
 
 
 
 
 
 
• Confirmation Warning appears. 
• Continue by clicking "Yes". 
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STEP 3 - Completing of Registration Form 
 
• You have now accessed the Man3000 Software Registration Form, please complete all 

the fields found within the form in detail. 
• Once completed the form must be Saved before the Print or Email Registration 

Form option will appear. 
• If the Print button does not come up, please make sure that the buffer and PC has 

proper two-way communication. 
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STEP 4 - Submitting the Registration Form 
 
Manual 
• Once the Technician has completed the Registration Form, submit the form along with 

an Official Purchase Order (if required) from the Support Company to Technical 
Information System via fax to be processed. 

 
Automatic 
• For automated registration options, use the Email Registration Form option and 

follow these steps: 
 

1. The technician should firstly phone into TIS’s server to obtain a one time password 
for the relevant registration and for this the technician needs to ensure his/her 
CLIP is activated on their cell phone to allow the server to recognize the number 
(technician). The server number to be dialled is 082-821 1766. Once this number 
is dialled, allow the call to ring three times only and do not wait for an answer and 
hang up. 

2. If you are a registered technician with Man3000, the system will automatically 
send you a SMS with the One Time Password. 

3. This One Time Password should only be used once and is only valid for two hours. 
4. The technician cell phone number and the One Time Password will be cross-

referenced when the registration code is generated. 
5. This process should be repeated when another registration is to be done. 

 
Complete Email Registration Form as follows: 

o Enter technician first name and surname. 
o Enter technician cell phone number. 
o Enter One Time password obtained in previous steps. 
o Confirm One Time Password. 
o Enter Job/Order number if required. 

       NB!! Ensure the details completed above are correct to ensure successful 
registration. 
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STEP 5 - Entering Registration Code 
 
Technical Information Systems will in return send the Support Company the Registration 
Code, which needs to be entered into the Registration Form, so that full functionality of 
the Man3000 Software may be accessed. 
 
To enter the Registration Code, you will need to access the Registration Form, once in 
the form: 
• Click the “Registration” button, which will allow you to edit the Registration Code 

field. 
• Enter your 16 digit Registration Code. NB Please make sure that you have entered 

the code correctly. 
• Save the changes to the Registration Form and Close. 
• Your Man3000 Software is now a Registered Version of Man3000 Telephone 

Management Software. 
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OPERATIONS MANUAL 
  

Introduction 
 
The MAN3000 Telephone Information Software provides a complete solution to the 
problem of controlling telephone overheads. 
 
Advantages of the MAN3000 Telephone Information Software are: 
 

9 Verification of the telephone account. 
 

9 Control the costs for individual extensions and departments. 
 

9 A means to establish when and by whom specific telephone calls were made. 
 

9 A means to immediately establish the cost of telephone calls just made. 
 
The objective of MAN3000 is to provide a Telephone Information System that is reliable 
and easy to use. The management system consists of a Buffer Box, (which is installed 
between the PABX and the PC) and PC Based Windows Software.  If no PABX is being 
used, a 4X4 Telephone Scanner can replace the Buffer Box. 
 
The Buffer Box receives information from the PABX, logs the correct date and time 
received from the PC for each telephone call record and stores these call records for later 
transmission to the PC. Approximately 3000 call records can be stored in a standard 
Buffer Box (upgradeable). The Buffer Box features an internal battery back up, allowing it 
to operate for 4 days in the absence of mains power. 
 
If a 4x4 Telephone Scanner is used, telephone calls are scanned directly from the 
exchange line and stored in the scanner. The Scanner can buffer +/-600 call records and 
can be upgraded to +/-2 000 call records.  These telephone call records will be 
transferred to the PC as in the case of a Buffer Box. The 4x4 Scanner also includes an 
internal battery back up. 
 
Each time the PC is switched on, (If the Man3000 program was added to the Start-Up 
menu) the Man3000 Software will retrieve the calls stored in the buffer box and transfer 
them to the database on the PC’s hard disk. Buffered call records are downloaded in 
minimal time and the PC is still available to execute its usual tasks. A special Data 
Transfer technique is used to transfer data between the buffer box and the PC; thus 
Telephone Call Records will not be lost in the event of a communication break. When it is 
desired to examine or view the telephone call information, this is accomplished with 
ease. 
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Features of the MAN3000 Program 
 
The MAN3000 software runs on any IBM compatible PC running on Windows ’95, ’98, 
’2000, ’NT 4.00, ’ ME, ’XP and ’Vista.  
 
The main features of the software are: 
 
• The costing and allocation of telephone calls are fully automatic. 
 
• Up to 20 000 extensions can be accommodated. 
 
• Carriers (i.e. Telkom, MTN, Vodacom, Cell C, Virgin Mobile, etc.) each having their 

own costing structure. (Multi Code Books). 
 
• 1000 Departments, each with it’s own costing. Extensions are associated with 

departments. 
  
• Departments are allocated with one of three mark-up percentages, which consist of 

three levels: 
 

o  Standard        114 % 
o  High              120 % (Standard Default Settings can be altered) 
o  Extra High     200 % (Standard Default Settings can be altered) 

 
• There are 20 000 Client telephone numbers. The option is used for displaying a 

client’s name on the Main screen and in the database, as well as on the reports 
instead of the telephone number. The client list can be enabled or disabled from the 
main screen, with the download screen being updated immediately. 

 
• You are able to view the extension and department names. Names can be displayed 

instead of the extension numbers and department numbers. 
 
• 20 000 Account codes of between 2 - 8 digits are accommodated. 
 
• Incoming Ring time and unanswered calls can be displayed. (PABX dependant) 
 
• Caller Line Identification can be viewed on Incoming Calls. (PABX dependant) 
 
• Multi-Level password protection. 
 
• There is NO INDEXING of the database, so no special care need be taken against 

power failures during database activities. 
 
• Highlighted calls that exceed specific costs, durations or ring times can be configured 

for easy viewing and reporting. 
 
• Comprehensive reports can be instantly and easily generated. 
 
• Text, Word, Excel and Acrobat Pdf. Reports 
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• Graph Reports (Bar Graphs and Pie Charts) 
 
• EMAILING of Reports (Microsoft Outlook 2000/SMTP) 
 
• MEMORISING and SCHEDULING of Reports. 
 
Dealer activated features. 
 
• Changing of default passwords. (Technical Password required). 
• Technical configuration of the Man3000 to communicate with the PABX and PC. 
• Networking multiple sites together, via LAN, WAN and Internet. 
• Integration to third party Hotel and Attorney Packages. 
• Billing structures for Tie Lines as well as Prime Net and Multiple Carriers. 
• Upgrading and maintenance of the Man3000 Telephone Information Software. 
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Activating the Program 
 
From the desktop of Windows ’2000, ’NT, ’ME, ’XP or ’Vista, double click on the Man3000 
icon. This will open the program. The MAN3000 Program can also be put into your Start-
up menu, so that when you log on to your computer, it will automatically open and 
download calls stored in the Buffer. 
 
How to put Man3000 into your Start up menu 
 

• Right click on the Man3000 icon on your Desktop 
• Select Copy 
• Right click on Start 
• Select Open. 
• Double Left click on the Program Folder 
• Double Left Click on the Start up Menu Folder 
• Right click in the Start up Menu Window and paste 

 
Man3000 has now been entered into your Start up, now when you start your Computer 
the Man3000 Telephone Information Software will automatically open and download the 
records that are stored in the Buffer Box. 
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Main Screen 
 
All the features of the program can be accessed from this main screen. Man3000 is a 
Windows multitask program and telephone calls will be downloaded automatically and 
continually as long as the program is open. The Main screen also displays the last 21 call 
records, each record is divided into ten columns. Below is an explanation of each in order 
from left to right: - 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
T                        
I  - Incoming Call record. 
S - Incoming Transferred Call record. 
O - Outgoing Call record. 
T - Outgoing Transferred Call record. 
U -Unanswered Call record. 
 
Number         
Outgoing Call number shows the number Dialled.  Incoming Call number if Caller Line  
Identification is activated or available, shows the incoming number. 
 
Area/Acc       
This column shows where the incoming call originated from or in the case of an outgoing 
call the destination of the call.  This column can also be set to show the account code 
used for that particular call. 
 
Ring               
The Ring time of the Call shows how long it takes for calls to be answered. 
 
Dep                
Shows to which Department the call has been processed. 
 
Line                
This column shows on which Exchange line the call was made or came in on. 
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Ext 
The Extension which answered the call or which extension made the call. 
 
Date & Time 
The date and time the call was made or received. This date and time is taken from the 
Man3000 Buffer Box which is set from the clients PC Date and Time. 
  
Duration          
Total Duration of the call. 
 
Cost                 
For outgoing call, the total cost of the call will be shown in this column. 
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Toolbar Menu 
  
File Menu 
 
Following activities are available under the Edit menu: 

• Enter Password 
• New Passwords 
• Printer Setup 
• Print Font Selection [Classic] 
• Printer Setup [Modern] 
• Export Telephone Database 
• Import Telephone Database 
• Automatic Export Text Format 
• Personal Copy 

  
Enter Password 
 
Type in your personal or default password. 
 
• You will then be able to activate certain functions of the program depending on the 

access level of your password. There are three passwords levels, each of which has 
different access levels. (Default passwords can be changed) 

 
 
 
 
 
 
 
 
 
PASSWORD LEVELS 
Operator Password will show an access level of 1 on your Key Icon Speed button. 
Forced Pin Password will show an access level of 2 on your Key Icon Speed button. 
Management Password will show an access level of 3 on your Key Icon Speed button. 
Technical Password will show an access level of 9 on your Key Icon Speed button. 
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New Passwords 
 
The default passwords supplied with the original installation can be altered or changed to 
suit the individual user. 
These changes can only be done by the technician with the technical password (level 9). 
The default passwords can also be disabled, for this option the technician needs to 
contact Technical Information Systems for advise on how this is done. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Password for Closing: 
This option allows for password verification before closing the program, thus password 
levels lower than the selected level will not be able to close the program. This is common 
when the telephone records are exported to third party packages, e.g. hotel packages 
where the costs from the Man3000 Telephone Information System is used for billing 
guests for the use of the telephone in the rooms. 
 
Password for Reports: 
This option allows for password verification before running a report, thus password levels 
lower than the selected level will not be able to run a report. 
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Printer Setup 
 
The “Printer Setup” option allows you to set-up the properties of your printer. 
 
Man3000 does not print directly to the printer, but sends a copy of the report file to 
Microsoft Windows and Windows copies the report file to the printer. 
 
In this window you can access your printers properties, setting up of your paper quality 
and page orientation e.g. portrait or landscape. 
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Printer Font Selection [Classic] 
 
• The “Printer Font Selection [Classic]” allows for customizing the Print job settings i.e. 

Size, Font style, etc. for the classic reports. 
• This option will ensure that all reports are printed in a text format. 
 
Man3000 Default Printer Font Settings 
 
Font = Courier New 
Font Style = Regular 
Size = 8 
 
These default settings are selected as the best way to view and print reports, but they 
can be changed to your own individual liking. 
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Printer Setup [Modern] 
 
• The “Printer Setup [Modern]” allows for customizing the modern reports. 
• If the “Use modern reports’ tab is ticked then all reports will be viewed, printed, 

emailed, etc. in a modern format. 
 
The report colour layout can be customized: 
- The Edit option allows for the colour scheme on the Header, Lines, Grand Totals 

and Page Numbers to be changed. 
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Export Telephone Database 
 
• The “Export Telephone Database” allows for the exporting telephone call records to a 

selected file in “Standard ASCII Comma Delimited Format”. Specify the date range of 
calls you want to export. All the calls will be written to the selected file for third party 
integration. 

 
• N.B. WHEN EXPORTING CALL RECORDS IT DOES NOT DELETE THE RECORDS FROM 

THE MAIN DATABASE, IT ONLY EXPORTS A COPY OF THE SPECIFIED CALL RECORDS. 
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Import Telephone Database 
 
• “Import Telephone Database” to import Telephone Call Records. 
 
• This function is either used to import telephone call records from the old DOS version 

of the Man3000 Telephone Information Software into the Windows Based Version or 
to Import data that has previously been exported for backup or interrogation. 

 
• To import records: 

o File 
o Import Telephone Database 
o Import from Date 
o Import to Date 
o Import File Name (Name of text file which was exported) 
o Click Start 

 
The records will be imported back into the Man3000 Database. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  



© Technical Information Systems, 2008 

 p21

Hotel Export Text Format 
 
SetUp 
 

• ASCII file : - 
o All Extensions : - Under the file||Hotel Export text format Menu 

Select a file name and a file path. Save the file in a text format. This will 
contain all the records for all the extensions. This may be any file name and 
any file location. 

 
 
 
 
 
 
 
 
 
Selected Extensions : - Under Edit||Edit Extension Info Menu 

Find the extensions that you would like to export to the Third party. Group 
these extensions to DEPARTMENT “97” (this is an automatic export 
department). The calls made for any Extension grouped into DEP 97 will 
automatically be written to a file w_dep_exp.txt in the Man3000 directory. 
The Third party would then pick up this file. 

 
• RS-232 (COM port) : - 

o All Extensions : - Under the file||Hotel Export text format Menu 
Set the file name to w_dep_exp. Set the file path to be in the Man3000 
directory. Save the file as a text file. You would now run the program  
File_2_coms.exe which will write all the extension records to a selected PC 
COM Port. (File_2_coms setup is explained under the following heading) 

o Selected Extensions : - Under Edit||Edit Extension Info Menu 
Find the extensions that you would like to export to the Third party. Group 
these extensions to DEPARTMENT “97” (this is an automatic export 
department). The calls made for any Extension grouped into DEP 97 will 
automatically be written to a file w_dep_exp.txt in the Man3000 directory. 
You would now run the program  File_2_coms.exe which will write all the 
extension records to a selected PC COM Port. (File_2_coms setup is 
explained under the following heading) 
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Personal Copy 
 
Export File 
 

• Select a file name for the Personal Copy File(e.g users name, PC name, 
Department etc). 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Import File  
 

• This option allows for automatic import of Personal Copy Import File on 
personal copy setup. 

• You would set the destination across the network to look at one of the exported 
files from the live copy of Man3000. 

• Set the Read and Write Options for Sync. 
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Sync Folder (ADVANCED TECHNICIANS ONLY) 
 

• This folder is set up when a different Sync path is required. 
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Edit Menu 
 
Following activities are available under the Edit menu: 

• Edit Extension Information 
• Edit Department Name  
• Edit Highlight Values 
• Edit Client List 
• Edit Exchange Line Telephone Numbers 
• Edit Client Category Selection 
• Edit Account Codes 

All these options except for Edit Highlight Values can be printed from these menu’s for 
easy reference. 
  
Edit Extension Information 
 
• “Edit Extension Information” Allocate a name to an extension number that has been 

created in the list according to the extension number sent out by the PABX and then 
to allocate each extension to a department. 

 
How to enter. 
• Click on the Add button to create a new extension number, and then double click in 

the field next to the extension number to add the extension name. Each extension 
must be allocated to a department by using the drop down menu. Prevision is 
made for a budget per day entry, which allows the customer to allocate and generate 
reports on budgets. 

 
Tip: 
First set-up the departments under ‘Edit Department Name’ before entering your 
extension information, it will eliminate the need to go back into Edit Extension 
Information afterwards to allocate your extensions to a department. 
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Edit Department Name 
 
• “Edit Department Name” Used for creating new departments and allocating each 

department to a specific telephone call charge rate. 
• Editing of your department names should be entered before entering extension 

names. 
• By assigning departments to extensions, the software is further customised to 

the customer’s requirements. 
• Select the Standard Unit Cost rate for standard call charges and the High or 

Extra High options when charging departments (e.g. office rental, guest, 
hotel, etc) for their telephone calls at a unit rate higher than that of the 
standard telephone rates. 

 
How to enter. 
• Select the department number required and in the column next to the number, enter 

the department name in the block labelled Department Name, e.g. Administration, 
Rented Office, Sales, Technical, etc. 

• Once that has been entered, move to the next block (Mark Up %) in line with 
Department Name and click on the arrow for the drop down menu to appear, there 
you can select from three options: Standard, High or Extra High. 
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Edit Highlight Values 
 
• “Edit Highlight Values” Set the Highlight Value of telephone call records, for Cost, 

Duration and Ring Time. 
• If any of these values are exceeded, the call record will be highlighted in the 

database. 
• A report/s of these calls can be generated under Extension Detailed Report, 

Department Summary Report, Top 40 and Exchange Line Summary Report. 
• An Automatic Email can now also be implemented; when the Highlight Values have 

been exceeded an email will be sent to the stipulated email address below. 
• The Email settings can now be via Outlook or SMTP. 
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Edit Client List 
 
• “Edit Client List.” Click “Add” to create a new Client name and number. 
• There are 20 000 Client telephone number entries available. 
• The client’s name will be displayed on the main screen and in the database, as well as 

on the reports. The name will be displayed in place of the telephone number. 
• The client list can be enabled or disabled from the main screen via speed buttons or 

the ‘view’ menu. This will be available immediately on the screen. 
• When entering a client to the list or editing an existing client, you can allocate the 

client to 1 of 20 categories i.e. Private or Business. 
• If the unauthorised feature is used and a call is dialled or received to/from that 

number, an email or SMS will automatically be sent to the designated receiver via 
Microsoft Outlook 2000 or SMTP. This call is then classed as an unauthorised call. 
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Edit Exchange Line Telephone Numbers 
 
• “Edit Exchange Line Telephone Numbers” First establish the port/line numbering 

scheme for your PABX. 
• Select the “Add” button to enter the number range. 
• An associated telephone number is now required per port/line number e.g. 

0114335621 > 201, 0114335622 > 701, etc. 
• Now allocate the appropriate carrier to the telephone numbers i.e. Telkom or Least 

cost routing via Vodacom, MTN, Cell “C” or Virgin Mobile packages. 
• These lines will now be costed at the applicable carrier call rates. 
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Edit Client Category Selection 
 
• Client Categories 1 - 20 can be edited to suit the client’s business needs. 
• By having client categories, reports can be generated by groups. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  
Edit Account Codes 
 
• “Edit Account Code Information.” Man3000 has the capacity to store up to 20 000 

account codes (2-8 digits in length). 
• The supply of account codes to Man3000 is PABX dependant. 
• An “Import” facility is available to import account code lists from other packages. 
• Reports can be generated on these account codes. 
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View Menu 
 
Speed buttons are available for all of the activities under the View Menu. 
 
The following activities are available under the View menu. 
 
 
• View Database 
 View Down Load Screen 
 Hide Down Load Screen 
 
 
• Display Client Names 
 View Client Names 
 Hide Client Names 
 
 
• Display Extension Names 
 View Extension Names 
 Hide Extension Names 
 
 
• Display Exchange Line Telephone Numbers 
 View Exch. Line Telephone Numbers 
 Hide Exch. Line Telephone Numbers 
 
 
• Display Department Names 
 View Department Names 
 Hide Department Names 
 
 
• Synchronise 
 Synchronise Personal copies 
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Reports Menu 
 
Report options/outputs: 
 
Reports viewed can be saved as: 
1. Word documents [.doc or .rtf] 
2. Excel documents [.xls] 
3. Adobe PDF files [.pdf] 
4. Text files [.txt] 
 
• Reports can be printed in the format selected in the Printer setup selection (Classic or 

Modern). 
• Specific entries can easily be located with the find tool built in the report viewer. 
 
Reports can be emailed via Microsoft Outlook 2000 or SMTP in the following formats: 
1. Word documents [.doc or .rtf] 
2. Excel documents [.xls] 
3. Adobe PDF files [.pdf] 
4. Text files [.txt] 
 
All reports can be emailed via Microsoft Outlook 2000 or SMTP: 
• Microsoft Outlook (2000) example: 

1. Internal or external mailing contacts through Microsoft Outlook 2000 address book. 
2. The mail will be sent to the Outbox of Microsoft Outlook. It will remain there until 

an Internet connection is established. 
3. E-mailing the same report to multiple parties i.e. all the sales staff. 
4. Sending a Guest report to a Guests company for processing. 
5. Paperless office option. 
 

• SMTP example: 
1. Generate report and click on the “Link to Email, Excel, Word, PDF or Text format” 

to select the relevant format to sent the report in via SMTP. 
2. Enter the destination email address and OK. The report will be transmitted 

immediately, providing the SMTP link is available and online. 
3. There is no log/report to confirm the successful transmission of the report. 
 
To set SMTP emailing option: 
• From the setting menu, go to the “Email Settings (Outlook/SMTP)”. 
• Change the option from Outlook 2000 to SMTP. 
• Enter Outgoing Mail SMTP Host. 
• Enter SMTP Port [25]: Default port is 25. 
• Enter SMTP Time Out mSec [1000]: Default is 1000ms. 
• Enter “From Email Address” which will display the origin of the email. 
• Enter “From Name” which will display the name where the email originated. 
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Extension Summary Report 
 
• This report gives a summary of telephone calls made and/or received on all 

extensions or selected extensions only. 
• Select the date range of the report. 
 
Additional Info: 
• Mobile phone Calls only. 
• International Calls only. 
• National Calls only. 
• Local Calls only. 
• Average Ring time & Average Duration. 
• Budgets. 
 
Page Settings: 
• Inserting page breaks in the report allows you to print the reports on single pages. 
 
Extensions: 
• All extensions or selected extensions. 
 
In/Out/Unans: 
Select one of the following: 
• All calls. 
• Outgoing calls only 
• Incoming calls only. 
• Unanswered calls only. 
• Out + Out Trans calls only. 
• Out Trans calls only. 
• In + In Trans calls only. 
• In Trans calls only. 
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Extension Outgoing Cost Report 
 
A summary report to compare traffic on Local, National, International and Mobile calls 
can be generated on all extensions or selected extensions. 
 
The date range for the report to be generated has to be selected. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  
Extension Detail Report 
 
Detailed reports can be generated on all extensions or individual extensions. 
This report will separate individual extensions call activity with the option of reporting on 
departments, mobile and highlighted calls. As for all the reports, the date range for the 
report to be generated has to be selected. In this report various options are available. 
 
Options: 
• Highlight Calls only 
• Mobile phone Calls only 
• International Only 
• National Calls Only 
• Local Calls Only 
• Select One Number 
• Client Category Selection 
 
Page Settings: 
• Add page breaks by Department; or 
• Add page breaks by Extensions. 
• Select Department order or Extension order. 
 
Departments: 
• All departments or selected departments. 
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Extensions: 
• All extensions; or selected extensions. 
• Budget percentages. 
 
In/Out/Unans: 
• You can select all calls, Incoming/Transferred, Outgoing/Transferred and Unanswered 

calls or you can select each option individually. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  



© Technical Information Systems, 2008 

 p35

Department Summary/Detailed Report 
 
This report will give a summary of calls made and received for all or selected 
departments within the date and time range specified. It will also add the totals for 
Unanswered, Incoming and Outgoing calls at the end of the report. The cost for each 
department will be indicated and the total cost will be calculated. Percentage split by call 
type i.e. local, national, mobile and international per department will be calculated. 
Extension totals only, Highlighted calls only or Client categories only may be selected. 
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Top 40 Calls (With the Options of Top 120 or Top 300) 
 
This report will give you the Top 40, 120 or 300 calls by: 
- Cost. 
- Duration, incoming and outgoing. 
- Most frequent telephone numbers. 
 
Options: 
• All Telephone Calls; 
• Mobile Phone Calls; 
• International Calls; 
• National Calls; 
• Local Calls; 
• Select number/dial code, thus any one number or numbers starting with a particular 

number: E.g.: 031, 011 or 5, etc. 
• In additional to the above, Highlighted calls only or Client categories only may be 

selected. 
 
Page Settings: 
• Add page breaks. 
• Total calls can either be: 

o Top 40, 
o Top 120 or 
o Top 300. 

 
Departments: 
• All departments or selected departments. 
 
Extensions: 
• All extensions or selected extensions. 
 
Exchange Lines: 
• All exchange lines or selected exchange lines. 
 
In/Out/Unans: 
• Various call options can be selected. 
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Exchange Summary Report 
 
Options: 
• List: Local, National, International, Mobile 
• List: Average Answer Time 
• High Light Calls only 
• Client Category Selection 
 
Page Settings: Add page break 
• None 
• Every 4 Exchange Lines 
• Every 5 Exchange Lines 
• Every 6 Exchange Lines 
 
Departments: 
• All departments or selected departments. 
 
Extensions: 
• All extensions or selected extensions. 
 
Exchange Lines: 
• All exchange lines or selected exchange lines. 
 
Errors: 
• Warn if Exchange Lines are Not Set up. 
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Exchange Detail Report 
 
Options: 
• All calls 
• Outgoing Calls only 
• Incoming Calls only 
• Unanswered Calls only 
• Mobile Phone Calls only 
• Select One Number 
• Out + Out Trans Calls only 
• Out Trans Calls only 
• In + In Trans Calls only 
• In Trans Calls only 
• Client Category Selection 
• High light Calls only 
 
Page Settings: 
• Add page breaks after each exchange line. 
 
Departments: 
• All departments or selected departments. 
 
Extensions: 
• All extensions or selected extensions. 
 
Exchange Lines: 
• All exchange lines or selected exchange lines. 
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Account Code Report 
 
If account codes have been entered and the Man3000 Telephone Information Software 
has been set-up to monitor the account codes, a detailed or summarized report based on 
these account codes can be generated. 
 
Options: 
• All calls 
• Outgoing Calls only 
• Incoming Calls only 
• Unanswered Calls only 
• Mobile Phone Calls only 
• Select One Number 
• Out + Out Trans Calls only 
• Out Trans Calls only 
• In + In Trans Calls only 
• In Trans Calls only 
• Client Category Selection 
• High light Calls only 
 
Page Settings: 
• Add page breaks between each account code. 
• Only Show Account Totals. 
• Hide Account Code Numbers. (Hides the account codes on the download screen as 

well as on the report.) 
 
Account Codes: 
• All account codes or selected account codes. 
 
Departments: 
• All departments or selected departments. 
 
Extensions: 
• All extensions or selected extensions. 
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Client list Report 
 
This report is useful when recording calls to and from your clients, which are in your 
Client List. 
 
Options: 
• All calls 
• Outgoing Calls only 
• Incoming Calls only 
• Unanswered Calls only 
• Mobile Phone Calls 
• Select One Number 
• Out + Out Trans Calls only 
• Out Trans Calls only 
• In + In Trans Calls only 
• In Trans Calls only 
• High light Calls only 
 
Page Settings: 
• Add page breaks between each Client number. 
• Only Show Client List Totals. 
 
Client List: 
• All used client list numbers or selected client list numbers 
 
Departments: 
• All departments or selected departments. 
 
Extensions: 
• All extensions or selected extensions. 
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Last Report Run 
 
This option refers to the last run report. 
  
Graphs 
 
These Graphs provide an easy to read Graphical representation of your Telephone Call 
Records. 
  
1. Busy Hour Graph 
 
Options: 

• Outgoing + Trans. 
• Incoming. 
• Unanswered. 
• 10 or 24-Hour X-Axis. 
• All or Selected Extensions. 
• All or Selected Departments. 
• All or Selected Exchange Lines. 
• All Clients or selected categories. 
• Can be viewed 3D or 2D. 
• Print. 
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2. History Graph 
 
This graph shows the trend of traffic on call records, which can be displayed in a Day, 
Week or Month format. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  
3. Extension Bar Graph 
 
This Graph shows you a graphical reflection of traffic per Extension number. 
 
Different telephone call types can be highlighted i.e. Incoming, outgoing + outgoing 
transferred and unanswered. 
 
• Number of Extensions can be changed in increments of 5. 
• All departments or selected departments. 
• All exchange lines or selected exchange lines. 
• Client category selection. 
• Traffic selection by number of calls, duration of calls, cost of calls and budgets are 

available for reporting. 
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4. Extension Pie Chart 
 
The Pie Chart shows traffic per extension on different call types. 
 

• Number of extensions can be chosen in increments of 5. 
• All departments or selected departments. 
• All exchange lines or selected exchange lines. 
• Client category selection. 
• Traffic selection by number of calls, duration of calls and cost of calls are available 

for reporting. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  
5. Exchange Line Bar Graph 
 
The Exchange Line Bar Graph can show traffic on telephone calls per exchange line/s. 
 

• Top Exchange Lines can be changed in increments of 5. 
• All extensions or selected extensions. 
• All departments or selected departments. 
• Client category selection. 
• Traffic selection by number of calls, duration of calls and cost of calls are 

available for reporting. 
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Tools Menu 
  
Price a Call 
 
This tool allows for determining the price of a call before the telephone call is made. A 
useful tool when making long distance calls or comparing cost of calls made on the 
different carriers (Standard Telkom lines or Least Cost Routers). 
 
• Type in the telephone number you wish to query. 
• Select the date and time the call will be made.  
• Select a mark-up percentage (useful in Hotel, Guesthouse, rented office space, etc. 

environment) or a customized codebook can also be selected and then the duration of 
the call.   

• Different carriers from the code book option can also be selected, e.g. Vodacom, MTN, 
Cell C or Virgin Mobile (for least cost routing) to validate the use of mobile phones 
calls made via a least cost router port/line or your landline calls made via the 
standard Telkom cost table. 

• Man3000 will then display the destination of the telephone call and calculates the 
costs via the Cost Table/s selected. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  



© Technical Information Systems, 2008 

 p46

Recost Telephone Call Records 
 
The Man3000 costs all telephone calls when they are written into the database.  If 
changes are made to the carriers, departments, extensions or telephone cost structure 
then the database can be recosted (Man3000 will recalculate the cost of every call from 
when the change or upgrade was made). 
 
E.g. This tool is used when there is tariff increases or changes in the cost of a telephone 
call allowing for recosting of the telephone call database, a least cost installation or the 
migration of a cellular package. 
 
Why is it useful? 
 

o Update call costs 
o Update client list 
o Update Extension names 
o Update Departments. 

 
 
 
 
 
 
 
 
 
 
  
Delete Telephone Call Records 
 
Deleting of telephone call records can be done once backups (the exporting of call 
records to file of choice) of the data have been completed.  If there is ever a need to 
check data that has been deleted out of the system, you can import your backups back 
into the system and regenerate reports.  The deleting of telephone call records is done on 
a minimum range of one full day. This option is password protected i.e. only the person 
with the Management password has the authority to delete records. 
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MEMORISED REPORTS 
  

Setting up Memorised Reports 
 
Introduction 
 
Memorised Reporting was added to the Man3000 Software to make the task of extracting 
reports convenient for you. 
 
In the Reports Menu, once you have opened your report you will need to select the drop 
down window to select which date range would best suit your needs. Various options are 
available for selection. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Once you have selected your Date Range, Additional Info, Page Settings, Extensions and 
In/Out/Unanswered information, you are ready to memorize your report. 
 
If your report is set-up to your satisfaction, click the memorize button. 
A smaller window will appear. Specify a file name for your Memorised report. 
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Run Reports Manually 
 
Memorised reports can be run manually by going to your reports menu and selecting 
Memorised reports and selecting which Memorised report you want to run. 
 
Memorised reports can also be scheduled to run automatically. 
 
 
 
 
 
 
 
 
 
• To run memorised reports manually, select the Report Menu and then select 

Memorised Reports. 
• A window will appear showing previously memorised reports. Select the report you 

wish to view and open. 
• On opening the report all that is needed is to view. No setting up is required. 
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Scheduling Memorised Reports 
 
• To schedule your pre saved memorised reports to run automatically, go to your Tools 

Menu and select Schedule Memorised Reports. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
• The following options are available: Print, Add, Edit and Delete. 

o Select Add to Schedule a pre saved memorised report. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
• Select the page icon button (Memorised Report Name) in the top left-hand corner to 

bring up a list of memorised reports, select the one you would like to schedule. 
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Next select Schedule Run Time. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
After selecting your Schedule Run Time, select the destination for the report. 
 

Three options are available 
 
1. Printer 
 
Reports can be printed in the modern format. 
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2. E-mail 
 
Reports can be emailed in the following formats: Word (.doc / .rtf), Excel (.xls), Text 
(.txt) and Adobe Acrobat (.pdf). 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  
3. Write to File (Can be used for Back-Up Purposes) 
 
Reports can be written to file in the following formats: Word (.doc / .rtf), Excel (.xls), 
Text (.txt) and Adobe Acrobat (.pdf). 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  
• 500 Scheduled Memorised Reports are available. 
• The same report can be printed, emailed and written to a file. 
• The same report can be emailed to multiple addresses. 
 

Click on “OK” to save the Scheduled Report. 
  



© Technical Information Systems, 2008 

 p52

BUDGET REPORTING & LIMIT 
NOTIFICATION 
  

Introduction 
 
Budget Reporting 
 
You can now set a Budget per Day for each Extension. Budget Reports can be generated 
to establish the extent of budget achieved for each extension user. The budget reports 
are found in the Extension Summary, Extension Detail and Extension Bar Graph reports. 
 
These reports can be automatically generated using Schedule Memorized Reports and 
can be sent to an Email Address; Printer or Written to a File. 
 
Telephone users are therefore always aware of their telephone performance against the 
allowed budget. 
  

Edit Extension Information 
 
In the column “Budget/Day”, type in the Budget value for each Extension. 
 
Once this Budget Value has been entered, you are now able to generate Reports. 
Simple select one of the Reports and click “View”. 
 
Example 
 
• R10 per Day if the Report is drawn for one day the Budget will be worked out on 

R10.00. 
• R10 per Day if the Report is drawn from Monday to Friday (5 Days) the Report will be 

worked out on R50.00. 
• So a Budget for R300 for the Month will be worked out as R300 divided by 22.5 

working Days which gives a Budget per day of R13.33. 
  

Extension Summary Report 
 
Select “Budget” on the Additional Info Tab. 
Click “VIEW” 
 
The Extension Summary Report will indicate standard information i.e., Unanswered Calls, 
Incoming Calls, Outgoing Calls as well as the Budget consumed for each extension in 
value as well as Percentage (%) 
 
If a Monthly Budget Report is required, set the average Budget/Day to a value of 
example R10.00 per day. In a typical month with 30 days, this will equal R300.00 a 
month. 
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Extension Detail Report 
 
Under the Ext Tab: 

o Select a Percentage (%) Value. 
o A report will be generated on all the selected extensions, which have exceeded 

the percentage value selected for the report. 
  

Extension Bar Graph 
 
This report gives you a graphical view of consumed Budgets for all or selected 
extensions. 
 
You can also Automatically generate the Extension Summary and Extension Detail 
report using Schedule Memorized Reports. This can be found under the Tools Menu. 
  

Limit Notification Introduction 
 
Man3000 can automatically notify the user when the allocated budget has been reached. 
In a guesthouse you can assign a credit limit to each guest room for telephone calls. 
When the credit limit has been reached you can then be notified by way of a Pop-up, E-
mail or SMS. 
 
This can be used in your general office environment as well. 
Set-up each extension into the Man3000 Guest Package and allocate a credit limit for 
each extension. 
  

Edit Guest/Room Info 
 
Select the extension/room to which the Limit will apply. 
Click on the Acc Tab and make a payment equal to the required Limit. 
 
• Create a Room with an Extension attached. 
• Book in the Person. 
• Make a payment equal to the Budget required. 
• Calls will now deduct off of the Amount. 
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To Set Notification 
 
Under the Guest Menu, select Set Guest Report Settings. 
On the Top Right hand side of the window, the options available are: 

o None 
o Pop-up Message 
o Send Email / SMS-> Internet 
o Lock Ext, Pin, W_Guest_Lock_Ext.Tis 

 
When the Pop-up option was selected and the user has exceeded the specified Limit, a 
“Pop-up Window” will appear and will also indicate the extent of the Limit exceeded. 
 
For Email / SMS Notification, enter an email address or SMS address in the fields 
provided. 
Save the Window and Close. 
 
Lock Extension this is for 4x4 Scanner Units only. 
  

Purge Telephone Calls 
 
Clicking the Purge Button will Clear all Telephone Calls from All Rooms effectively 
resetting all Budgets. 
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GUEST PACKAGE 
  

Guest Menu 
 
The Guest Package is aimed at Bed & Breakfast establishments, Guest Lodges, small 
establishments and sub-letting part of your office space which is serviced by a PABX or 
4X4 Scanner. The System allows you to charge for consumables or services for clients. 
  

Setting Guest Items 
 
Select Guest Î Set Guest Items  
 
You have the following options: 

o Add Items, e.g. Single Room, Double Room, Room Service, Laundry, etc. 
o Delete Items. 
o Edit Items, e.g. if prices have increased. 
o Print. 

 
To add an Item you would Î                    the following screen will appear, in which you 
would enter your required Description, the Cost and the VAT percentage. 
Your Item Code will normally continue after your last entered Item Code in Sequence, 
but you also have the option of selecting another Item Code Number. 
 
 
 
 
 
 
 
 
 
 
 
 
 
To delete an Item you would Î an Item  
 

then Î                   a confirmation block will appear to confirm that that is the Item you 
would like to delete. 
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To Edit an Item you would � an Item as in deleting an Item then Î                     
the following screen will appear, in which you will be able to Edit your Description, Cost 
or VAT Percentage if required. 
 
 
 
 
 
 
 
 
 
 
 
 
To Print your Item List Î . 
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Setting Guest Payments 
 
Select Guest Î Set Guest Payment  
 
You have the following options: 
• Add Payment Methods, e.g. Deposit, Cash, Credit Card or Prepaid Vouchers, etc. 
• Delete Payment Methods. 
• Edit Payment Methods. 
 
To add a Payment Method you would Î                         the following screen will appear, 
in which you would enter your required Description, the Cost and the VAT percentage. 
Your Item Code will normally continue after your last entered Item Code in Sequence, 
but you also have the option of selecting another Item Code Number. 
 
 
 
 
 
 
 
 
 
 
 
 
To delete an Payment Method you would Î an Item   
 

then Î                          a confirmation block will appear to confirm that that is the 
Payment Method you would like to delete. 
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To Edit a Payment Method you would Î a Payment Method as in deleting a Payment  
 

Method then Î                         the following screen will appear, in which you will be  
able to Edit your Description, Cost or VAT Percentage if required. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
To Print your Payment Method List Î . 
 
 
 
 
 
 
 
 
 
 
 
 
 
  

Setting Guest Report 
 
• This option allows you to customise your reports by entering your establishment’s 

details, thus personalising your Guest Report. 
• By default, the Maximum Invoice Number is set to 9999, this means that after invoice 

number 9999 it will reset back to number one. 
• The Client has the option of leaving blank lines open on the top of the Guest Report 

printout for printing on letterheads. 
• When customising Reports you have the option of adding VAT to the telephone call 

records as well as adding a page break between items and the telephone call records. 
• You are able to export your data to Microsoft Excel for further analysis. 
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Edit Guest/Room Info 
 
Once the previous editing functions have been set up you can now start using the Guest 
Package. 
 
This screen is where the main functions take place. 

o Adding of extension numbers - these numbers will be the physical extension 
numbers of each room/office. 

o Adding of room names - these names are the names you have allocated to each 
room/office e.g. Room 1. 

 
 
 
 
 
 
 
 
 
 
 
 

o Booking in of New Guests. 
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Editing the Guest information. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

o Viewing Guest Accounts. 
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Booking in a Guest 
 
• Go to Guest/Room Info 
• Select the relevant room and then New Guest 
• Complete details 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  

Guest Account 
  

Adding Items to Guest Account 
 
• Select Guest/Room Info 
• Highlight Guest/Room 
• Select Acc Button 
• Select Add Item 
• Then select which item on the list you require 
• Select Quantity and edit amount if needed. 
  

Processing Payments 
 
• Select Guest/Room Info 
• Select Room Acc 
• Select Payment 

o Total is shown on Header Bar 
• Enter payment method, e.g. Deposit, Vouchers or Credit card, etc. and enter amount. 
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Guest Report 
 
Once payment has been entered, select the Print button on your screen. This will bring 
up a Print preview screen, which allows you to print a copy of the Tax Invoice/Non Tax 
Invoice for your Guest. An option to E-mail this invoice is also available for the Guest. 
  

Booking Out a Guest 
 
• In the Guest Account, select the Out Button. 
• A warning window will appear confirming the booking out of a specific Guest/Room. 
• Once you have agreed, the room will be cleared for future use. 
 
If a Guest is to be booked out but the room balance is not at a zero balance, an error will 
appear; “Are you sure you want to book out? 
 

If a call is made from a vacant room, a warning will 
automatically appear on your screen. 

  

View Old Guest Reports 
 
For follow up, all Guest Reports are saved in the Man3000 system files. 
Once a Guest has been booked out, the Guest Package makes use of the Invoice number 
as a reference to save Guest Reports.  
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MAN3000 PERSONAL COPY AND 
SYNCHRONISATION 
  

Man3000 Personal Copy 
 
INTRODUCTION 
The Man3000 networking has been changed to offer live reporting and down loading of 
data on multiple computers within the same company network. This is referred to as a 
personal copy. 
  
Installation Step 1 
Man3000 Live 
 
• Install the Man3000 software onto the host/master computer on the company’s 

network. 
• This copy of Man3000 will have the buffer box connected. 
• Set the software up completely: PABX formats, serial port settings, etc. 
• Once everything is working correctly register the software with T.I.S. 
  
Installation Step 2 
Export to Personal Copy 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
• Establish how many personal copies are required. (How many computers need access 

to Man3000). 
• Open the Man3000 copy on the host/master computer. 
• Enter your technical password. 
• Open the file menu. 
• Open the Personal Copy Menu. 
• Click on Add. 
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• Select a file name. 
o Note that this file name could have any name, e.g.: the name of the 

person/machine for applicable personal copy, e.g. Reception, Data, John, etc.  
 
**NB!! Each personal copy must have a different file name!! NB** 

 
Make sure that the Sync folder created on the host/master PC is fully shared on 

the network. 
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Installation Step 3 
 
Import to Personal Copy 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
• Install the same version of Man3000 software on the personal computer that 

requires access to the host/master copy of Man3000. 
• Enter your technical password. 
• Open the file menu. 
• Open the Personal Copy Menu. 
• Select Personal Copy Import file. 
• Browse through the network to the computer with the host/master Man3000 on it. 
• Browse to the “Sync” folder and select the corresponding export file name pre-saved 

in step 2. 
• You will now have live records being recorded on the personal copy. 
• Synchronize the host/master copy with the personal copies, see the chapter on 

synchronization. 
 
**NB** No com port should be selected **NB** 
 

• Once everything is working correctly, register the software with T.I.S. 
 

Important: 
Remember when registering the personal copy, ensure that at least one telephone record 
has been recorded in the personal copy database, this will ensure that the serial number 
of the master/live copy is being transferred to the personal copy to allow registration. 
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Synchronization 
 
INTRODUCTION 
 
Should you be running more than one copy of Man3000 on a company’s network using 
the “Personal copy” Method, you would require synchronization of all your critical data. 
This data includes your Extension information, Department information, Client list 
information, Exchange Line information, Account codes and your Client Categories. 
 
Setup 
 
• Enter your technical password on the host/master copy of Man3000. 
• Go to the File menu. 
• Go to the Personal Copy menu. 
• You would have already set-up the export paths to all the other personal copies. 
• The option for synchronization of extension names, departments, client list, etc. 

should be configured as follows: 
o Initially the WR should be ticked on the live/host/master copy and RD on the 

personal copies, only until all the copies are updated and then the permissions 
can be changed to suit desired result.  

o All changes made to any of the extensions, departments, etc., will be written to 
the sync folder on the host/master copy and will update all the other personal 
copies, depending on their permissions. 

  
Permissions 
 
Two user classes are catered for, namely Read and Write. 
• The Read option, only allows for reading changes made in the master files (RD). 
• The Write option allows for updating and reading of the master files (WR). 
 
All updates in the master files will be distributed to all the personal copies. 
This is fully automatic and requires no user intervention.  
 
Sync Folder (ADVANCED TECHNICIANS ONLY) 
 

• This folder is set up when a different Sync path is required. 
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4 x 4 TELEPHONE SCANNER 
  

1. Introduction 
 
The 4x4 Telephone Scanner is designed to monitor and control telephone calls on 
Standard Telkom Analogue Telephone Lines as well as Least Cost Routers. The 4x4 
Scanner is contained in a robust housing making it suitable for any type of environment. 
The Scanner is connected to an IBM PC. The entire configuration settings are done 
through the PC and are password protected. The 4x4 Scanner can monitor between 1 and 
16 exchange lines, or it can front end a PABX, PBX or DPS system. At the end of each 
telephone call made, the Scanner will store all the details relating to that telephone call. 
  

2. Features of the 4 x 4 Scanner 
 
• The 4x4 Scanner is SATRA approved, licence number AFR26. 
 
• Requires a PC using Microsoft Windows ’95/’98/’2000/’Nt/’ME/’XP or ’Vista. 
 
• Telephone Calls are Time and Date stamped. Off hook Duration, Dialled Number or 

CLI, Account Code, Exchange Line number used and Extension number used forms 
part of the Telephone call record. 

 
• The PC need NOT be dedicated to the 4X4 Scanner. The scanner stores +/-600 

telephone call records in its memory. This can be upgraded to +/-2000 telephone calls 
records. 

 
• The 4x4 Scanner has battery back up. 
 
• The Option of forced Pin Access.  

160 Pin numbers are available for the option of forced pin access. Anyone wishing to 
make a call must enter his/her personal pin number, before he/she is able to make a 
telephone call. The call will be registered to his/her name and not his/her extension 
number. 

 
• 100 Emergency Numbers available, which are always unlocked. 
 
 
Although being configured differently, the same reports are available as in the Man3000 
Telephone Information Software. (Refer to Chap 1) 
  

3. Account Coding 
 
After the dialled number has been dialled using pin access, a ‘*’ or ‘#’ dialled will force 
the account code feature, any digits which are then entered will be stored in the account 
code field of the Man3000 software. Reports can be extracted on these account codes. 
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4. Setting up Pin Numbers 
 
There are 160 pin numbers available on the system. These pin numbers are set on the 
PC under “Edit Extension Information”. Each pin number is associated with a user 
number, starting from “100”. If a telephone call is made using the PIN number, that call 
will be logged to a specific user. 
 
If an incorrect pin number is dialled or if a phone number is dialled without the use of a 
Pin Number, the call will be cut off. All numbers in the Emergency number list can be 
dialled without the use of a pin number. 
  

Portable Class of Service 
 
160 pin numbers are available. Certain pin numbers may have different levels of access 
(if the portable class of service feature is activated on the scanner) for example: 
 

o Pin numbers starting with a 1; 8; or 9, may only make local calls. 
o Pin numbers starting with a 6; or 7, may only make local, national and 

mobile phone calls. 
o Pin numbers starting with a 5, may only make local and national calls. 
o Pin numbers starting with a 4, may only make local and mobile phone 

calls. 
o Pin numbers starting with a 0; 2 or 3, may make calls to any number. 

 
For more information about this option, please contact your dealer. 
  

4.1 How to make a Call using Pin Access 
 
To make a call which is normally blocked by the route restriction, the user will lift the 
handset, select a line if on a PABX extension, DPS or Router, make sure to wait for Dial 
tone, then dial “*” and then the 4 digit pin number. The scanner will detect this and if the 
pin number is valid, will cut the line for 2 seconds for verification and restore the line 
again thus giving dial tone. The telephone call can now be made on this line. If the user 
needs to make another call, the same procedure has to be repeated. If pulse phones are 
being used the “*” must be replaced with “11”. 
 
The redial feature cannot be used on the scanner and must be disabled. 
 
NOTE:  If a DPS Elite telephone is used, the exchange line will be cut off once the pin 
number has been entered and the same exchange line must then be selected to allow 
telephone calls to be made. 
 


